
RealtiWeb® Ontario Advanced User Guide
This guide is for the more advanced features like editing master documents and exporting to e-reg.

Other guides available include:

Basic User Guide
The basic tasks to open and complete a real estate deal

Administrator User Guide
For Administrators of LDD RealtiWeb Accounts

Accounting Integration Guides
Setup and manage imports and exports to/from accounting packages, including PCLaw and CosmoLex

Title and Writ Search Guide
Use Teranet capabilities without leaving your RealtiWeb screens
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File List on Main Screen
From the Main page you will see your firm’s files. This list can be customized by clicking the cog icon
Edit List.  Any change to the file list display will be reflected for all users.

A�er clicking the cog icon, a page will load to allow you to set the columns and sort the file list.

Clicking the database button will open a popup with all the fields that can be used as columns. Click
on the field you want to display in the file list.

If you want to change the order of the columns, right click on a field, three options will appear:
● Move Field Up: This will move the field higher in the list of fields being shown.
● Move Field Down: This will move the field lower in the list of fields.
● Remove Field: This will remove the field from the list.

The Sort Order column sets how to order the list. For example, setting the list to display in order of file
number.

Use the Piggy Bank to save your changes, and the Trash Bin to restore the file list settings.

Note: Changing the list view will change it for all users.

Additional Create a File Methods
The Basic User guide outlined how to create a new file from the main page. There are other methods
for creating (or opening) a file, which are: copying from an existing file, or creating a file from a
template.

Copy Existing File
Under File select the Copy Existing File option. This will change the page to showing a list of your files
(you are able to switch between Recent files and Activate files).

Find the file you wish to copy in your list of files and select it. You are able to use the Filter across the
top to help in your search.

Deselect (or uncheck) the checkboxes you do not want included, and check the information you do
want copied into your new file. A�er you are happy with what is being copied click “OK”.

Note: You are unable to copy both the Purchaser and Vendor as Purchasers (or Vendors).

The popup will close a�er clicking “OK” and the page will load the new file. Complete this screen as
described in the Basic User guide, clicking the Continue button to finish creating the file.
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Create a File Template
First you will need to save a file as a template. This can be an existing file or a newly created file for a
specific template purpose.

File Template Creation
Open a file you want to save as a template. Click on the chevron beside the Basic button and select
Save File As Template in the dropdown menu.

A�er selecting Save File As Template a popup will appear.

By default, the Create New Template will be selected, which will save the template as a new template.
Enter a name for the template in the New Template Name field. A�erwards, check off the items that
you do not want saved as part of the template. Once you're finished click Save, and a popup message
should appear letting you know the template was saved successfully.

Note: Any TitlePLUS details, Registration details and the File Number will always be removed.

If you have existing templates and wish to overwrite one, change the radio button selection to
Overwrite Existing Template. This will change the New Template Name to Select Template To
Overwrite, where you can use the database button to select a template to overwrite.

Create New File From Template
Now that the File Template has been created, a new file can be created using the defaults set up in the
File Template.

Choose the File Template you want for the new file and click the Create button.

A�er clicking the Create button, you will be taken to the new file screen to complete the file creation.
Note any information in the template will already be populated into the applicable fields.

Specific Database Features
Firm Contacts
You have to manage Firm Contacts from within a RealtiWeb file. Open a file and click the database
button, beside the Firm Contact field.

Clicking the database button will open a new popup window with the list of all your firm contacts. If
you are editing an existing contact, use the Edit to open the Staff Information and update the
information.

If you are adding a new Firm Contact, then click on Add at the top of the list.
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The Staff Information screen will load for you to complete. For the UserID, click the database button
to access the list of users on the firm account. Select the user who corresponds to the staff member
being added.

A�er you have completed the Staff Information for the staff member, click Update List across the top
of the Staff Information popup. This will update your Firm Contact database to include the staff
member for future files.

Law Society Import
To maintain or update your firm’s Other Side’s Lawyer database, you can import directly from the
Law Society of Ontario. Click the database button beside the Other Side’s Lawyer field.

A popup window will appear with a few options. Click Start a New Search… to open the Law Society
of Ontario‘s Lawyer and Paralegal Directory. The page will be ready for you to enter your search
criteria and continue.

A�er the search, select the Full Name of the lawyer you are looking for. The Lawyer Contact
Information will be shown with a green Add to LDD button. Click Add to LDD to import the
information into RealtiWeb.

The Law Society of Ontario website will close and the selected lawyer’s contact details will load in
RealtiWeb. To continue your lawyer import, click Select this Lawyer.

The popup will be replaced with the lawyer’s contact information in the format RealtiWeb requires. It
is recommended you review the imported information and add in any missing details you know. To
finish the import, click “OK”. This will set the Other Side’s Lawyer in the file to the imported lawyer.

If you want to use the imported lawyer in other files, you can click Update List to add the entry to your
lawyer database.

Note: Click “OK” for any changes to the lawyer entry to be updated in the RealtiWeb file. If you click
Update List (updating in the database), and close the popup the changes will not be in your file. For
your changes to be reflected in the RealtiWeb file, you must click “OK” before closing the popup.

In addition, if you close the popup, Cancel, or Select Another your changes will be lost.

Real Estate Agent and Broker Search
To locate brokerages and real estate agents for maintaining your firm’s Real Estate Broker database,
click on the database button beside the Real Estate Broker field on the Contract Details tab.

A popup window will open for search criteria to be entered. A�er clicking Submit the search results
will load. Click on the real estate agent or broker to add it to your firm’s database.

To maintain your database of brokerages and agents switch to the All Real Estate Agents tab. From
here you can use the Delete and Edit beside each real estate broker. The Delete will remove the entry
from your database, and cannot be restored. The edit button will open the entry for it to be updated.
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Calendar Feature
At the bottom of the main page, you will see the Calendar. It will show you closing, requisition and
contract dates of your deals. You can open any of the exhibited deals by clicking them. The Calendar
feature is accessible from within a file, by clicking the Calendar (in the upper right corner).

Calendar Views
By default, the Calendar will show you the weekly schedule of your deals. You are able to switch
between daily, weekly and monthly views by clicking on the Daily, Monthly, and Weekly buttons. The
current view is identified with a red circle.

You can switch the date range (within the view) by clicking the arrows beside the date range. This will
let you see the previous or following day, week, or month (depending on the selected view).

The Clock (in the lower right corner of the Calendar) enables you to add appointments to the
Calendar.

Clicking the Clock will open a new window that will let you select the appointment type, details of the
appointment, date and time, whether or not the appointment is private, and the file to which to link
the appointment.

Note: Checking the appointment as Private will limit who has access to editing and seeing the
appointment.

Calendar Settings
You can add reminders to your calendar to remind you of important events that are going to take place
on any of your files. The system sets up the following standard dates for you automatically (all default
system preferences can be modified):

● Closing Date
● Tickler for Closing Date
● Requisition Date

● Tickler for TitlePLUS Pre-approval
● Tickler for Undertaking Complied With
● Tickler for Mortgage Discharge Complied With

You have the option to add the following dates, or any other dates you wish to set up:

● Title Search Ordered
● Title Search Completed
● Municipal Searches Completed
● Fire Insurance Information

Confirmation Completed
● Report to Client Completed

● Report to Lender Completed
● Appointment with Client to Sign Documents

for Closing
● Mortgage Advance Requested
● Mortgage Advance Required

Note: Any changes made will only display on newly created files, or existing files AFTER entering the
file and saving, this updates the calendar with the new settings for that particular file.
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Using the Calendar Preferences feature, you can set up your Calendar to select which dates you
would like to view and when you would like to view them. From the main page, select Tools →
Calendar Preferences.

Use Calendar Preferences to set how you want to see the files listed, and which items you want to see
displayed on the Calendar.

Use the radio buttons underneath Show files on Calendar by to switch between showing files by
client name or file #. For selecting which items you want to see, click the checkbox beside the
particular item (under Description).

For each item, you are able to select when to display it on the Calendar. Under Display there is a text
field for the number of days (ie. 2 or 4), and a dropdown menu to select if the alert should appear
before or a�er. The Date dropdown allows you to select which date you want to count from/to.

Note: If you leave the number of days blank, the system will interpret it as zero.

If you want to show the event on everyone’s calendar, leave the Display On Clerk Calendar
unchecked and Display on Another Person’s Calendar blank.

Alternatively, checking the Display on Clerk Calendar will show the event on the Firm Contact
calendar. In addition, selecting a person from the user list (open using the database button) will show
the event on the selected person’s calendar. A�er selecting a user from the list, their name will appear.

Note: If you are not using a LDD Account, then do not use the Clerk or Another Person’s calendar
indicators. If you wish to use these indicators, please contact our support team at support@ldd.ca or
1-800-363-2253.

Management Reports
All reports created in RealtiWeb will use information pertaining to your firm and files.

Producing Management Reports
To produce a report, go to File → Reports.

You can select a Standard Report (a report listed in black font and is provided by LawyerDoneDeal
Corp.) or a Customized Report (a report that has been modified or created by you or someone else at
your firm).

If you select a Standard Report, the fields used in the selected report will display on the le� side of the
screen underneath Report Settings. To the right of each field is the criteria for each field.

The fields are automatically checked off to show in the report. Uncheck the checkboxes under Show
for any fields you do not want visible in the report.
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Note: Each Field will be a column in your generated report.

Click GO to generate the report. If you checked off Show Sequence? then the first column in the report
will show the line item number.

Use the Printable Version to print the report (the button will open the report in a new browser tab for
printing). If you want to change the report, click Customize the selected report button to return to
the previous screen.

Customizing Management Reports
A�er selecting a report (or clicking the Create button under the list of reports and naming your new
report), you are able to customize the report.

If you want to add more fields, click the database button beside the empty field on the le�. This will
open a popup with all the possible fields you can add to your report. Alternatively, you can use the
database button beside an existing field to change it.

If you want to only include certain files based on one of your fields, you can use the Criteria
dropdown to select a condition. A�er selecting a condition, you will see new fields to the right of the
Criteria. These fields are used by the system to determine what should be brought into the report.

In case you want the report to be in a specific order, you can change the order in three ways.
1. Click the heading of the column you want to sort by.
2. Type in an order in the Sort Order column (beside the Show checkboxes).
3. Right-clicking the Field and selecting Move Column Up or Move Column Down (note that only

applicable options are in black font and are clickable).

A�er you have finished modifying the report, click Save (at the top of the page) to save your changes.

If you want this to be a new report click Create. This will open a text field underneath the Create
button for the new report’s name/title. Click “OK”, a�er you have entered a report name. The report
will be available the next time you login.

Note: You cannot save changes to a Standard Report. To keep your changes, click Create, enter a
report name, and click “OK”. The report with your changes will now be saved.

Alternatively, you can click Duplicate and then Save.

User Defined Fields
User Defined Fields are fields you can add to RealtiWeb for your firm. These fields are treated like any
other field in RealtiWeb and are highly customizable. They can be used to combine other fields
together, calculations or adding additional information to your RealtiWeb files.

User Defined Fields are found under Tools → User Defined Fields.
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Creating User Defined Fields
Follow these steps to add a custom field:

1. Click Add User Field to add an empty line to the bottom of the list for your custom field.

2. Add the name of your new field under Caption. This should be something easy to understand
across your firm.

3. Next select the Data Type and Size (if applicable) for the new field. The Size of the field is the
number of characters allowed to be entered into the field.

Note: If a user enters a value that exceeds the character limit, they will receive an error
message.

4. Set the Location (a.k.a. page or screen) for the field to appear. The field will appear at the
bottom of the section selected.

5. Click the Piggy Bank icon to save your changes.

Optional - Edit User Defined Fields
A�er setting the Caption, Data Type, Size (if applicable) and Location for the custom field, an edit
button will be between the Size and Location columns. (If you want an empty field, do not Edit the
custom field.)

Clicking the edit button will open the Field Formula popup window. Here you are able to set formulas
for the custom field. If you have basic programming knowledge, you will find that adding a formula to
the custom field is easier than someone without this knowledge.

Using the Add… button
The Add… button has three options to select from: operators/functions, conditions, and other.

The operators/functions option is for help with building formulas, especially when setting a date type
field or rounding a variable. The conditions are predetermined formulas, while the other option adds
a blank field.

Using the Add Field button
One main reason for creating a User Defined Field is to create a new field with a formula. The Add
Field button is perfect to use for simplistic formulas.

For example, if a firm only accepts 10% of the purchase price as a first deposit, they can create a First
deposit. The firm could use the following steps to calculate 10% of the purchase price:

1. Click the edit button.
2. Click Add Field.
3. Find and click on the Purchase Price field.
4. Type in “* .01”. The formula will appear.
5. Click Close. (Do not click the “X” of the popup - this will result in you losing all your changes.)
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Master Documents
You are able to edit existing or create your own documents in RealtiWeb. Editing master documents
includes adding your custom fields into your documents.

A�er logging into RealtiWeb, hover over the Tools in the navigation across the top and select
Documents.

This will load the Master Documents area. Here you are able to manage all your RealtiWeb
documents.

Creating your own documents in RealtiWeb
To create your own document, click the Add a new document… link in the upper right corner.

The Add a new document wizard will open. This wizard allows you to easily define the attributes of
your new document by walking you through a 5 step process.

Add a new document wizard
Step 1: Enter the name of your document, then click Next>.

Step 2: If applicable, select a Document Category. When you are finished, click Next>.

Step 3: Check off all the file types your new document will be relevant to.

Step 4: Use the dropdown menu to select a Document Template that matches the formatting
requirements of your new document.

Step 5: Indicate whether or not your document needs to be looped. This determines how
many different dra�s of your document you get at one time.

If you require looping, select the Need to loop based on radio button and use the dropdown
menu to select a field to loop on. For example, if there are two mortgages in your file, and your
document is mortgage form, then you would set the Loop Status to loop by New Mortgages
(all) or a specific type of mortgage to loop on.

When you are finished with the wizard, click Finish to begin writing your new document.

A�er completing the Add a new document wizard, you will be sent to the Document Editing page.
This page is divided into two sections: Document Setup and Document Body.

Document Setup
The Document Setup will have your settings from the Add a new document wizard. Use the Edit
Attributes to change any of your selections, except Document Template.

Note: To change the Document Template click the blue pencil beside the database button. This will
allow you to then click the database button to open the list of document templates. Select the new
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template you want to use.

Click on the blue Click to Edit Margins, Font etc. link to change the margins, size and fonts of the
document. The blue link will open the Document Format Specific Details popup with all the
document settings.

The last part of the Document Setup section tells you what the Format, Title, Header and
Declaration Line of your new document are. By default these are the same as your selected template,
and the default of the template is on the right. You may change these settings on the le�.

Document Body
The Document Body is where you add your document clauses.

The first part of the Document Body is a text field for your clauses. To begin, click the light bulb icon
to add a new clause to your document.

A clause editor will open in the empty text area (underneath the light bulb icon). This clause editor
will allow you to easily format text, create tables and columns, and insert fields.

You can select the following functions from the clause editor toolbar:

● Cut
● Copy
● Paste without Format
● Paste with Format
● Underline
● Undo
● Bold

● Italic
● Underline
● Strike Through
● Subscript
● Superscript
● Alignment
● Justification

If you want to add a field into the clause text, click the F icon (between the checkbox and table
properties icons). This will open the List of All Fields (including your custom fields), find and click the
field you want to add into the clause.

To close the clause editor, click outside it.

If you want to add more than one clause, click the light bulb icon again to add another clause.

Each clause has its own attributes, allowing you to include it according to logical circumstances. Once
you write a clause you can save it to a library for use in other documents. Right-click anywhere on the
clause to change its properties.

The last option, Properties/Conditions, will open the Clause Properties popup.

The Clause Properties popup enables you to name your clause (Clause Name), select Group
Headings, when to apply the clause (the checkboxes for Purchase, Sale and Mortgage transactions),
type the Conditions (while using the Add…, Add Field, Clear, Copy, Paste and Check buttons), and
when the clause should loop (if applicable).

The Add… button will open a small window with 3 tabs: Operators, Conditions, and Counts.
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The Operators lets you determine the logic along with the Add Field button (on the main popup) to
write your own condition for the clause.

The Conditions option is programmed with default conditions and does not require Operators (unless
you are writing multiple conditions for the clause).

The Counts option enables you to condition the clause by how many items are in the file. This is useful
for when you want to write a clause based on when there is 1 transferee and another clause for when
there are multiple transferees on a file.

For example, if you want a conditional clause for when there is only 1 transferee then you can follow
these steps:

1. Click Counts. This will show a list of available variables the system is able to count.

2. Scroll down and click the variable Transferees.

This represents that the system will count the number of transferees on the RealtiWeb file, as
it merges the document.

3. Next you should select a ‘comparison operator’.

4. In the grey text field, enter 1.

5. The condition itself tells the system to: Include this clause in the document when the Count of
Transferees is equal to 1.

Note: If you wish to use text in the grey field (instead of a number), please place the text within
apostrophes (‘).

The Add Field button (on the Properties/Conditions) will open a new popup, with a list of all the
fields you are able to include in your clause. The other buttons, Clear, Copy and Paste, are consistent
with the rest of RealtiWeb.

The Check button is to see if your condition is ‘readable’ to the system. A�er you have written your
condition, click Check. If the system is able to understand your condition then the outline will change
from black to green. If the system can not understand the condition, then the outline will change to
red and a popup message will appear with the issue.

Beneath your text field for adding clauses, you will see the dropdown menus for Signature, Electronic
Signature, Declaration and Commissioner, and checkbox for Exclude Brackets to set the default
settings for the document.

A�er you have completed all your changes, click Save at the top of the page to save your new
document. The document will now be available to others in your firm from the Docs screen (when
within a file).
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If you right click a clause and reenter the Properties/Condition option, you will see a few more
settings. These settings let you to set spacing and page breaks for when the document is merged. This
helps with formatting your document to ensure headings are always at the top of a page, etc.

If you want to create a copy of your document (or one of the standard RealtiWeb documents), click
Duplicate. This will create a copy of the opened document.

The Remove Document button (beside Duplicate) will delete your created document from RealtiWeb.

Modifying Existing Documents
You are able to modify your custom documents and the standard RealtiWeb documents. Go to the
Master Documents area to find and select the document you want to modify.

For example, if you select Acknowledgment of Conflict - Purchaser the Document Editing page will
open. Here you are able to edit the document (similar to when you created a new document, but all
the fields will have existing data).

A�er your edits, you can click Save or Duplicate. The Save button will save the document, while the
Duplicate button will copy your changes and then you can Save.

If you save a Standard RealtiWeb Document, then a new button Restore LDD Document will appear
beside Duplicate. The Restore LDD Document button will revert your document back to the Standard
RealtiWeb Document.

Note: You will lose all your changes, if you click Restore LDD Document.

Organizing your Master Documents into Packages
RealtiWeb enables you to create your own document packages. To work with your packages, select
the transaction type you want to work with by changing the Show documents apply to: dropdown.

For the purposes of this guide Purchase will be used. This will filter the documents to only show
documents applicable to Purchase files, and the radio button Package will appear.

Clicking the plus icon beside a package name, expands the package to show all the documents inside.

There will be a Document Package Configuration option above the list of document packages. The
Add enables you to create your own package for the transaction type. Meanwhile, Save will save the
configuration. The LDD Once and LDD Always will revert your packages back to their original states.

Creating a New Package
Clicking Add will create a package at the end of the list of packages. The new package will be
highlighted in blue, indicating you are editing the name. Start typing the name of your package, and
click elsewhere on the page when you are finished typing the name.

Right-click your package name. You will then see several options, select Add a Document from List.
(The other options are covered in the subsequent two sections.)
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A�er clicking the Add a Document from List option, the list of your documents (for the specified
transaction type) will appear. Click the document you wish to add into your package.

Note: You are only able to add one document at a time to your package.

If you click the plus icon it will expand the package to show all documents in the package.

Organizing your Documents within a Package
A�er clicking the plus icon to view the documents inside the package, you are able to access document
specific options. Right-click on a document name to open the document specific options. Note the
document-specific options have changed from grey to black.

Move Document Up This will bring the document higher up the list.

Move Document Down This will lower the document in the list.

Remove from this Package Clicking this will remove the document from the package.

Set Document Condition This will open a popup, where you can set the condition of when to
include the document in the package. This works the same as setting
conditions on clauses within a document (refer to page 35 for help
with writing conditions).

Switch Page Number
Reset

Clicking this will switch rsm pg# from (no) to (yes), and vice versa. To
view the document conditions, refer to page 42.

Organizing your Packages
If you right-click on a package name, you will see a list of options. Underneath Add a Document from
List, is the available options for rearranging your packages.

Move Package Up This will bring the package higher in the list.

Move Package Down This will lower the package in the list.

Rename this Package Clicking this will highlight the package name in blue, and you will be
able to rename the package.

Copy this Package This will duplicate the package and name the copy with Copy of
before the name of the original document.

Delete this Package Clicking this will delete the package from your list. Deleting a package
cannot be undone.

Show/Hide Doc Conditions This will show all the conditions and whether or not the page
numbers are reset for each document within a package. (If you are
already seeing the conditions, this option will hide them.)
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Advanced Document Merging Options
A�er you have selected a document to open (on the Docs button screen), the document will merge.
This means that the relevant information in your RealtiWeb file has been put into the document.

Across the top of the merged document, you will see Save, Save As, Print, Print Preview, Share, PDF,
MS Word, and OpenOffice. In this guide we are focusing on the Share, PDF, MS Word, and OpenOffice
options. If you want to learn about the other options, please refer to the Basic User guide.

Share
The Share option enables you to email the document to another law firm (or someone inside your
firm), or to post the document to LDD WebDocumentRetrieval® to a lawyer.

Email Docs
If you click on Share or hover over the word and select Email docs (from the dropdown menu), you
will begin emailing the merged document(s).

Setting up Document Emailing
Before you can start emailing documents, you will have to verify your email. If you click Email docs, a
popup will appear explaining to verify your email address. In the popup, click the word VERIFY to
begin verifying your email.

A popup will appear, letting you know that the verification email was sent. Simply, click “OK” and
check your email.

In the email, click the blue verification link. In a new browser tab, you will see confirmation that the
email has been verified. Return to RealtiWeb (in Internet Explorer), and re-select your document(s)
you want to email.

Emailing Documents Process
A�er clicking the Email Docs option (or Share), a popup will appear. Enter the email addresses you are
sending the document(s) to. Separate each email address using ‘;’. Please be advised that the email
limit is 5 recipients in each of the three options (To:, CC:, and BCC:).

Note: If you want a copy of your email, we recommend adding your email address in the BCC: field.
This will secretly send the email to you, without the other recipients knowing.

You may change the Subject: field text to change the subject line of the email. The document(s) you
are attaching have two options: attaching as a PDF or inserting into the email body. The dropdown
defaults to Attach PDF, but you may change it to Don’t Attach. If you do not attach the document(s) as
a PDF, then click Document into Email Body (or if you want the document as a PDF and in the email
body). This will load the entire document into the email body.

Beneath the options for attaching/inserting the document(s) are the buttons for editing the body of
your email, and the email body.
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Note: There is no guarantee that you will receive a Read Receipt response back. Certain email
providers, such as GMAIL do not recognize this feature, and some recipients may have their settings
set up to not send a Read Receipt email for privacy.

A�er you are finished writing your email, click Send at the top of the popup to send your email. The
popup will close and a new Email Sent Successfully popup will appear. Click “OK” to the Email Sent
Successfully popup.

Note: The Discard button will delete your email dra�.

Posting Documents
You are able to post documents regardless of having an Other Side’s Lawyer listed in the file.

If you do not have an Other Side’s Lawyer listed in the file, then you will see the LDD Firm Search.
Simply, enter the Firm Name, City or Postal Code of the law firm you want to post the documents to,
and click Search.

The search results will load, showing the Firm Name, Street Address, City, Postal Code, and Phone
Number of the law firm. Select the firm you are trying to post the document(s) to.

Note: If you have an Other Side’s Lawyer listed in the file, then the system will automatically match
the other side’s lawyer with an LDD User Firm. If the system is unable to properly match an LDD
User Firm with the Other Side’s Lawyer, then it will enter the Firm Name, City and Postal Code
from the file into the search and load the search results. You will then have to manually select the
firm.

Note: If you are unable to find a matching firm then use the Create button at the bottom of the
popup. This will let you post the document(s) and email instructions to them through LDD’s Email
Service. It is recommended to copy the instructions and email them to the other side’s lawyer from
your own email, to ensure they receive the instructions.

The Other Side’s Lawyer field will auto-complete with what is in the RealtiWeb file. If this field is
blank, complete the Other Side’s Lawyer field on the Basic screen. The Match LDD User Firm will be
filled in with what the system has identified or what you selected from the search results. If you want
to change either the Firm Contact use the database button (to select another firm contact) or the edit
button. To change the Match LDD User Firm, use the database button.

You will be able to add a Posting Note (up to 128 characters), and check off the information you wish
to send. The last checkbox, you may check off to send an email to the Other Side’s Lawyer for them to
know the document(s) were posted for them.

Click Post to finish your posting.
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PDF
There are three options under PDF, these are: Open Acrobat, Download, and Save to Hard Drive.

A�er clicking Download, you will see a popup across the bottom of your screen. You may Open the file
in Acrobat, Save (which will default to where you save your downloads), or Save As (which will let you
select where to save the file). All saved versions will be in PDF format.

MS Word
There are two options underneath MS Word, these are: Open in MS Word and Save to Hard Drive.
Open in MS Word will open the document in Microso� Word. The Save to Hard Drive will save the
document as a Word doc on your computer.

Advanced Label/Envelope/Fax Functions
Adding and Editing Your Contacts
The Label/Envelope/Fax is a contact manager that will collect all your contact information on a file in
one place and enable you to create labels, envelopes and fax cover sheets for any of the contacts on
the RealtiWeb file. Any changes to contact information will change the information in your file.

Access the Label/Envelope/Fax a�er clicking the Docs button.

The checkbox beside each contact name allows you to select the contact you want to use when
creating your Label, Envelope, or Fax Cover.

To see or edit any of the contact information, click the plus icon to expand the contact.

If you want to add more contacts (who are not included by default), you can add them under Extra
Contacts. Simply, enter the name (First name(s) followed by Last name) into the Extra Contacts text
field. When you either hit the Enter key (on your keyboard) or click outside the field, the additional
fields will appear, followed by a new Extra Contact text field (in case you want to add more than 1
extra contact).

The last part of the popup window is the Municipal Offices/Utilities. You can use the database button
beside the field to select any of the searches you have chosen for the file’s municipality. These include:

● Assessment Office
● Airport Zoning
● Bank Act
● Bankruptcy
● Building/Zoning
● Bulk Sales Act
● Canada Shipping Act
● Cemetery
● Certificate of

Compliance

● Engineering and Water
Mains

● Environmental Protection
● Farm Tax Reduction
● Fire Dept
● Fuel Safety
● Gas
● Hanover,

Tax/Building/Zoning/Water
● Health Dept

● Registered
Agreement
Compliance

● Residential
Tenancy Ministry

● Residential
Tenancy Municipal

● Restricted Area
Building Permit

● Septic Tank
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● Certificate of
Compliance - Expedited

● Certificate of Status
● Conservation Authority
● Corp Status Federal
● Corp Status Provincial
● Corporate File Search
● Corporate Name Search
● Corporation Profile

Report
● Corporations

Information Act
● Copyrights
● Crown Patent
● Electrical Work Orders
● Elevator

● Heritage Act
● Highway Entrance
● Hydro/Public Utilities
● Land Registry Office
● Local Improvements
● Local Roads
● Local Unregistered

Easements
● Mining Act
● Navigable Waters
● Ontario Hydro Electrical

Inspection
● Partnership Name Search
● Personal Property Security

Act
● Provincial Land Tax

● Shoreline Property
● Subdivision/Develo

pment Agreement
● Tarion
● Tax Certificate
● Tax Search
● Tile Drainage
● Trade Marks
● Unregistered Hydro

Easements
● Water
● Well Driller

Certificate

Label Setup and Printing
To set the quantity of labels you want, complete the Start Label # field.

For example, if you enter 2 into the Start Label # field then the first label will be printed in the upper
right corner.

Note: By default the Start Label # will start at 1, which means that the labels will start printing in the
upper le� corner.

You are able to change how the labels are printed by changing the settings. You are able to open the
label settings by clicking Setup.

In the Setup popup, enter your label specifications (including paper size). Click Save when you are
satisfied with your changes.

Note: That if you change any of the specifications for the Label, click Refresh above the Label
Sheet View to update how the labels will be printed.

You are also able to change the text of your label from the standard text from this popup. Simply
change the radio button under Label Advanced Settings to Customize the label text. A text field will
appear with editing options.

Note: It is recommended you click [ADDRESS] to insert where the address for each contact will
appear. Without this identifier none of your labels will print the contacts’ address.

Once you are happy with your changes click the Save button.
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A�er saving, close the Setup popup to return to the Label/Envelope/Fax popup. If you click the
Labels button, you will see your labels open in a new window for you to print.

Envelope Setup and Printing
Setting up and printing envelopes are similar to labels. Click Setup from the Label/Envelope/Fax
popup. At the end of the Setup popup, you will see the Envelope Setup (a�er the Label Sheet Setup).

Note: If you click Refresh above the Envelope View, you will be able to see your changes.

A�er you have completed your changes, click Save.

When you click the Envelopes button (on the main Label/Envelope/Fax popup), your envelopes will
open in a new window for you to review and print them.

Other Label/Envelope/Fax Functions
From the Label/Envelope/Fax popup, you are able to open your Fax Covers and Blank Letters for
printing. Simply click on the corresponding button.

Note: You are able to edit your Fax Covers and Blank Letters from the Document Control and
selecting Fax Cover Sheet Blank or Letter - Blank, respectfully.

Additional Mortgage Button Features
Versions of Schedules
RealtiWeb has Bank-issued schedules, which can be completed within the system. These schedules
can be exported into Teraview from within RealtiWeb, or converted into a PDF file for e-reg.

Converting Schedule into a PDF file (E-Reg PDF)
Assuming there is at least one schedule on the RealtiWeb file, you will be able to convert your
Schedule(s) into PDF format. If you need help on adding a Schedule to the RealtiWeb file, refer to the
Basic User guide.

Click on Additional Terms or Click here to go to Lender Schedules. This will open the popup
showing you all the schedules on your file.

You will see the e-reg PDF button, beside the Schedule. Click the button to open the Schedule in
Adobe. You may save or print the PDF file. The system will assume you are sending the PDF separately
to Teraview, and will check off the Exclude from Export to e-reg? checkbox. This means if you decide
to export information to e-reg, the mortgage schedule will be excluded (unless you manually uncheck
the checkbox).
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Downloading from third party
If your mortgage instructions are in a third party portal, they can be copied from the portal and
brought into RealtiWeb. To add the mortgage instructions into your file, click on the chevron on the
Basic button and click Import from third party.

A popup will appear. Select where you are importing from in the dropdown menu. A�er your selection,
please follow the instructions in the popup.

OREA Forms
Accessing and Using OREA Standard Forms in RealtiWeb
LawyerDoneDeal has over 75 of the Ontario Real Estate Association (OREA) Standard Forms in
English - online and ready for you, when you need. Just like other RealtiWeb documents, you
complete the required information in your RealtiWeb file, select the appropriate forms, schedules with
clauses, and then RealtiWeb automatically generates the forms with the required information in the
proper areas. A�erwards, you can merge and print a PDF version of the OREA form(s).

Note: Since the forms are now part of RealtiWeb, we recommend that you save the data in our
database instead of saving the completed Acrobat PDF forms to your desktop. Remember, you can
always change the data in the database and then remerge the form again, as many times as you like.

If you have subscribed to OREA through LawyerDoneDeal, then when you click on the OREA Forms
button at the top of the Docs screen you will open a popup. This popup will allow you to create the
OREA forms you need.

The OREA forms will pre-populate with information you have entered into your file and you may add
other clauses, etc., to your agreement from the OREA form area.  These documents are trademarked
by the Ontario Real Estate Board and are available to LDD users for the yearly license fee charged by
OREA.

If you click on the OREA Forms button and receive a popup message, clicking “OK” will send you to a
new page where you can subscribe to the OREA Standard Forms through LawyerDoneDeal.

A�er clicking “OK” to the popup, you will be brought to the next screen. Click the Purchase button to
start the buying process of the OREA Standard Forms subscription through LawyerDoneDeal.

Accessing OREA Standard Forms
From the Files section of the RealtiWeb main menu, select the client file for which you want to create
OREA forms. The selected file will open.

Click the Docs button to open the Documents area. Then click the OREA Forms button.
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To use the OREA Standard Forms
Use the OREA Standard Forms popup to complete any additional required information, select the
appropriate forms, schedules and clauses, and then RealtiWeb automatically fills in the OREA forms
you require.

Note: In this instruction set, an Agreement of Purchase and Sale is used as an example, so you can
learn about the process of completing OREA Standard Forms.

On the OREA Standard Forms popup, select the APS Details tab (by default this tab opens). Complete
all the fields.

Tip: Remember, the information in these fields populates the Agreement of Purchase and Sale;
ensure you complete the appropriate fields.

Click the Property Details tab, and then complete the appropriate fields.

Note: The Property Type is required. Ensure you complete the Property Details on this popup, and
then complete the Legal Description on the Property tab (under the Basics button).

Click the Miscellaneous tab, and then click the checkbox of the form(s) required, such as the Remove
Conditions (Form 121).

Tip: A�er you click the checkbox of the form you want, the system displays other fields that are
specific to this form. Ensure you complete them. You can select all the other forms you require using
the Miscellaneous tab.

Adding a Schedule
To add a schedule, such as the Schedule 100, on the OREA Standard Forms popup, click the
Schedules button.

On the Schedules screen, to add a Schedule, click on the database button beside the Schedule # field.
A new popup will appear with a list of schedule numbers. Select the appropriate number, such as 112.

To add a new clause to the Schedule, click the Add New Clause button, click the category and then
select the clause you require.

Tip: Use your mouse to highlight the clause you want and then click it. You can add as many clauses
as you need, one clause at a time.

To add other Schedules, click the Schedule tab, which will show a blank Schedule. Simply, click the
database button beside the empty Schedule # field and complete the other fields as necessary. This
works similarly to adding additional mortgages on the Mortgage button.

To create the Schedule(s), click Click to Create All Schedules.
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To create an OREA form
To create an OREA form (such as an APS), on the OREA Standard Forms popup, click the Forms
button. An OREA forms window will open.

On the OREA Standard Forms popup, click the form you require, such as Notice of Fulfillment of
Conditions. The system creates the form in a Portable Document Format (PDF) file. Use the options
across the top of the PDF window to print the form.

About Rental Agreements
You can create OREA Rental agreement forms for residential and commercial leases. Use the Rental
Agreement tab, and then click the button that applies to the type of agreement you require.

To create a Rental Agreement
The process you use to create a residential and commercial agreement is very similar. In the following
example, you will create a commercial tenancy lease agreement.

Note: If you have already created a tenancy in the Issues button and completed any of the fields in
the New Tenancy popup, when you click the rental agreement form displays automatically with
your completed information.

On the OREA Standard Forms popup, click the Rental Agreements button. The screen will show two
buttons (Create New Residential Tenancy and Create New Commercial Tenancy). The first is for a
residential tenancy, while the latter is for commercial tenancies.  If a tenancy is being completed as
part of the transaction, you enter the tenancy information into the Master Issues List tab (under
Issues button) plus the further information requested here and can produce a lease in the document
section of the OREA forms.

Click Create New Commercial Tenancy to begin creating a commercial tenancy. The applicable fields
will appear for adding a commercial tenancy. Complete the required fields.

Tip: The system defaults to the short form for commercial agreements. To use the long commercial
form, on the commercial tenancy form popup, click the Longform (Form 510)? checkbox.

If you require more than 1 tenancy, click on Create New Residential Tenancy or Create New
Commercial Tenancy (depending on which type is appropriate). This will add an additional tab
underneath the two buttons. You are able to switch between the two (or more) tenancies, by clicking
the appropriate tab. This is similar to when there is more than 1 mortgage on a file.

To create the commercial agreement on the OREA Standard Forms popup, click on Forms, and then
select Agreement to Lease (Commercial). The system will create and open the form as a PDF file.
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Account Security / Change Password
To change your password, follow these steps:

1. Login to your account.
2. Click the Change Password link in the Administrative section.
3. A new browser tab will open with the fields to change your account password.
4. A�er entering your current password and desired password, click Update.

Note: Passwords can only contain letters and numbers.

Billing
Information pertaining to the firm’s billing with LDD can be found under Billing.

If you select Billing → LDD Billing Statements, the page will load with the list of billing statements.
This page loads all the transactions within the current year, including the current month.

Note: Save PDF versions of the billed statements for your firm’s records.

You can view upcoming transactions, by selecting Billing → Upcoming Payments.

Further Help and Support
We want to ensure your complete satisfaction with our products. Should you have any questions or
experience any problems or difficulties with using RealtiWeb, please do not hesitate to contact our
Support team. You can contact us as shown below:

Phone 800-363-2253 ext. 0
416-367-0600 ext. 0

Email support@ldd.ca
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